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Useful Tips

Here are some useful tips that will help you use this guide effectively.

1. Copy the tutorial part files in a location other than the installation folder to make sure
you have read/write privileges to the files.

2. Once you start working with the tutorial file, save your work periodically!

3. Don’t stress out too much if you are having trouble with the tutorial.  Call us or send us
email and we can help you out.

4. Most of all have fun!
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What's New

You can find out What's New in the latest release of VisualCAM for SOLIDWORKS here:

Related Topics

What's New in VisualCAM 2018 for SOLIDWORKS

https://mecsoft.com/WhatsNew/WhatsNewInVisualCAM2018ForSOLIDWORKS.pdf
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Videos & Guides

Quick Start Guides for each VisualCAM for SOLIDWORKS module are available in both PDF
and Video format.  Refer to the following information to access these guides:

2018 Quick Start Guide Videos

VisualCAM 2018 for SOLIDWORKS Automatic Feature Machining (AFM) Quick Start

VisualCAM 2018 for SOLIDWORKS MILL Quick Start

VisualCAM 2018 for SOLIDWORKS TURN Quick Start

VisualCAM 2018 for SOLIDWORKS, 2½ Axis Introduction

VisualCAM 2018 for SOLIDWORKS, 3 Axis Introduction

VisualCAM 2018 for SOLIDWORKS, 4 Axis Introduction

The Complete 2018 Video Play List

Here is a link to the complete 2018 Video Play List

How to Access the 2018 Quick Start Guide Documents

To help you quickly get started in working with each module, select one of the Help
files located on the VisualCAM for SOLIDWORKS Learning Resources dialog.  

You will find:

· Data Sheets  

· Quick Start Guides  

· What's New documents  

· Online Help links

The Quick Start Guides will help you step through an example tutorial which will
illustrate how to use the module.  To access the Learning Resources dialog:

1. From the SolidWorks menu bar, locate the VisualCAM main menu and select
Learn ...  

https://youtu.be/af2zcE0o67Q
https://youtu.be/iZ3rlA8JCqg
https://youtu.be/jgC40bRmGcY
https://youtu.be/rboHKAbC0m4
https://youtu.be/YohHGRrr2JQ
https://youtu.be/cdL3Pq6XzIQ
https://www.youtube.com/playlist?list=PLx9G05pFm0QLovWp5Z_fxkPUqPgjUGJpV
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To access the Learning Resources dialog for SolidWorks 2015 and above

2. Select a document from the Learning Resources dialog to get started using
the module of your choice.

Learning Resources dialog
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About this Guide

About the TURN Module

The VisualCAM for SOLIDWORKS TURN module offers fast gouge free solids/surface model
machining technology coupled with cutting simulation/verification capabilities for programming
2 Axis CNC Lathes, running inside SolidWorks. This integration allows for seamless
generation of toolpath and cut material simulation/verification inside SolidWorks for
programming CNC lathes that support 2 axis machining.

The module also comes with numerous post-processors to output the programmed G-code
to some of the most popular machines on the market.  A simple and well thought-out user
interface makes this system one of the most intuitive and easy to use.

You can work with native SolidWorks data as well as any of the data and file types that can be
imported into SolidWorks for solids, surfaces and mesh objects. Then you can use the
VisualCAM for SOLIDWORKS TURN module with its wide selection of tools and tool path
strategies to create machining operations and associated tool paths for 2 Axis Lathes. These
tool paths can be simulated, verified, and finally post-processed to the controller of your
choice.

On-line help compiled on: Friday, April 6, 2018

VisualCAM for SolidWorks TURN Quick Start Guide

Using this Guide

If you have installed VisualCAM for SOLIDWORKS successfully on your computer and are
now looking at the blank screen and wondering what to do next, this is the guide for you.  This
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guide will explain how to get started in using the VisualCAM for SOLIDWORKS TURN module
to program a simple part through an example.  

This guide will illustrate how to machine a part using Turn Roughing and Finishing operations.
Even though we are using a 3D model, it will become apparent as we go that we could also
machine this part using just a 2-D curve.  Since all parts that can be created in a 2-Axis lathe
are solids or surface of revolutions, it is enough to just describe the profile that needs to be
revolved to create this shape.

This guide has two associated SOLIDWORKS files that you can find located in the
QuickStart folder under the installation folder.  The first is a finished file that contains all of the
completed toolpaths and machining operations and represents the file that you should end up
with after working through this guide. The other is a starter file that contains only the
geometry.  Use the completed file as a reference.  Copy the starter file and use it to begin the
guide.

TURNQuickStartTutorial.SLDPRT
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Getting Ready

Running VisualCAM for SOLIDWORKS

Locate the SolidWorks shortcut on your desktop and double click to launch the application.   

Alternatively you can also click on the Windows Start button and select All Programs.  Go to
the program group containing SolidWorks. (The name of this program group will usually be
called SolidWorks, unless you specified otherwise during setup.)

Once you locate the program group, select it and then select SolidWorks to launch the
application.

If the installation was successful, upon launching of SolidWorks and opening a Part document
you should observe a menu entry called VisualCAM 2018 in the main menu bar of
SolidWorks.  In addition to this you should see the CAM Browser window automatically loaded
as a tab in Feature Manager.

If you do not see this menu entry then please check the On Line Help document of the
product (found in the installation folder) for help with trouble shooting the installation.

VisualCAM 2018 for SolidWorks only operates in the Part
(MILL & TURN) or Assembly (MILL ONLY) mode of

SolidWorks.  If you are running in the Drawing mode of
SolidWorks you will not see VisualCAM's menu bar loaded in the
SolidWorks menu.

Machining Strategy

Based on the type of geometry of this part, we will machine this model out of a cylindrical
aluminum blank that is 3 inches diameter and a minimum length of 3 ¼ inches.  As the part
has only features on the outer diameter (OD) to be machined, we will machine this out by
using a Turn Roughing and a Finishing operation.  We will also use just a single diamond
insert with a 20 degree relief angle and 0.02 inch tip radius with 0.5 inch inscribed circle
radius for performing all machining. We will also assume that the cylinder blank will be held
on the chuck over to the left side on the CNC lathe.

Main Programming Steps

The following steps will be followed in machining this model.  Some of these steps will have to
be performed just once and others may have to be repeated to complete the machining.

1. Define the Machine and Post Processor to use.

2. Define the Part and Stock Geometry, Material and Work Zero.

3. Create and Select a Tool to use for machining
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4. Create the Machining Operations including the Feeds and Speeds, the Clearance
Geometry and other Cutting Parameters.

5. Generate the toolpaths.

6. Simulate the toolpaths.

7. Post Process the toolpaths.

8. Generate Shop documentation.

Load the Part Model

The Part typically is the geometry that represents the final manufactured product.   

1. Select Open from the File Menu.

2. From the Open dialog box, select the TURNQuickStartTutorial.sldprt file from the C:
\ProgramData\MecSoft Corporation\VisualCAM 2018 for SolidWorks\QuickStart\
folder.  As mentioned before, it is advisable to make a copy of this part at a suitable
alternative folder so that you have write privileges to modify the part.

By default, the ProgramData folder is "hidden" from view.  Here are
the steps to Show hidden files and folders:

1. For Windows7/8 users: Go to Control Panel > Appearance and
Personalization > Folder Options.

2. Select View tab and under advanced settings select Show Hidden
files and folders, clear the check boxes for:

· Hide extensions for known file types  

· Hide protected operating system files (Recommended)  
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3. Click Apply and OK.

The part appears as shown below

TURNQuickStartTutorial.SLDPRT

In the future you can import 2D drawings, Solid, Surface
and Mesh models that are supported in SolidWorks.

3. The CAM Browser window is automatically loaded and appears in the Feature
Manager as a separate tab, called the VisualCAM 2018 tab, as shown below.
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Launch the TURN Module

By default the MILL module should be loaded and the MILL browser window will be displayed
in the CAM Browser located in Feature Manager.  We need to change to the TURN module to
program our part.  There are different ways to do this.  Refer to each method below.

1. First make sure the TURN module is loaded:

Method 1:

For SolidWorks 2015 and higher, select Tools, VisualCAM 2018 and then pick TURN
from the menu:

For SolidWorks 2010 - 2014, select VisualCAM 2018 from the main menu bar and
then pick TURN.
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Method 2:

Select the Turning Browser button from the VisualCAM 2018 tab of the SolidWorks
Command Manager.

Method 3:

You can toggle between the MILL and the TURN browsers by selecting MILL/TURN tab
located at the top/left side of the Machining Browser as shown below:

2. You will see two dialogs, one called the Machining Browser and the other called the
Machining Objects Browser displayed in the CAM Browser window of the Feature
Manager.
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The Machining Browser is also referred to as the Machining Operations Browser or
the Mops Browser.   The Machining Objects Browser is also referred to as the Mobs
Browser.

3. You can also re-size the height and width of the browser making sure that all of the
command icons and menus are easily accessible.
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Define the Machine Tool

The first step in the machining process is to define the machine tool to use.  

1. Select the Program tab from the Machining Browser and pick Lathe to display the
Machine Tool Setup dialog.

2. Select the Machine Tool Coordinate System tab.  This dialog allows you to setup the
Machine Tool Coordinate system (MCS).



Getting Ready 17

© 2018 MecSoft Corporation

Now select the World Coordinate System button.  In this tutorial we align the
Machining Coordinate System to the World Coordinate System (WCS).

Notice that when this button is selected, the MCS Z axis coincides with the X axis of
the WCS, and the X axis of the MCS coincides with the Y axis of the WCS.  This is the
default settings in the TURN module.

Typically in 2 axes Lathes, the rotary axis of the lathe is
considered the Z axis while the axis perpendicular to it and

pointing upwards is considered the X axis.  The TURN module
also follows this convention and requires 2D geometry used for
toolpath programming as well as the toolpath coordinates to be on
this ZX plane of the MCS.

3. Now select the Turn Machining Setup tab.  This tab allows you to setup some
machine tool control parameters.

4. Set the Maximum RPM to 10000.
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5. Click OK and notice that Machine - Lathe is defined under Machining Job tree in the
Machining Browser.

Select the Post Processor

Next, we'll define the Post Processor.

1. From the Program tab select Post to display the dialog.
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2. For the Current Post Processor, select Fanuc from the list of available posts.  

3. Then set the Posted File Extension to .nc.  Other file extensions are available
depending on your machine requirements. 
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4. Pick OK and notice that the Post type is now defined under the Machining Job tree in
the Machining Browser.
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By default, post processor files are located under:

C:\ProgramData\MecSoft Corporation\VisualCAM 2018 for
SolidWorks\Posts\TURN\

The program to send the posted output is set to notepad.
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Defining the Machine Setup

Define the Part Geometry

Part Geometry constitutes the end product of the manufacturing operation. The TURN module
requires you to select solid/surfaces/polygon meshes or curves that defines the part
geometry.  Once selected this part geometry will be used for all machining operations.

1. From the Program tab select Part to display the dialog.

2. Pick the Select Surfaces(s) button.
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3. The dialog is minimized and allows us to select Part Objects.

4. Press Ctrl+A to select all geometry and then pick the  icon to complete the
selection.

5. The dialog reappears and lists the selected surfaces under Selected Machining
Features.
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6. Now pick Save.

7. The Part is now defined and listed under the Machining Job in the Machining Browser.
 



Defining the Machine Setup 25

© 2018 MecSoft Corporation

8. Now select Part - Defined from the Machining Job in the Machining Browser.  You can
see the actual 2D profile that was created to use in toolpath computations.

In the future, if surfaces are selected as part geometry, the
system will slice the selected surfaces with the ZX plane of

the Machine Coordinate System (MCS) and use the resultant
curves as the actual profile to be machined on the lathe.  

Alternatively you can perform the slicing using CAD tools and
select just the resultant curve as the part profile.  If you select a
curve to represent the Part, make sure the curve is a 2D curve
that lies in the ZX plane of the MCS.  By default the ZX plane is the
same as the XY plane of the World Coordinate System.
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Create the Stock Geometry

In this step we'll define the raw stock from which to cut the part.

1. From the Program tab select Stock and then select Cylinder Stock from the menu to
display the dialog.

2. Under Outer Dimensions, set Radius (R) to 1.5 and Length (L) to 3.25.
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3. Pick OK and notice that Stock - Cylinder Stock type now appears under Machining Job
in the Machining Browser.
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4. If the stock does not display on the screen when selecting Stock - Cylinder Stock from
the Machining Browser, select the Stock Visibility icon located at the base of the
Machining Browser.
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Align the Part and Stock

Once the stock model is created you can move it in alignment with the part if needed.

1. From the Program tab select Align.

2. For Z Alignment select Right and then pick OK.
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3. If you switch to the Front View, you see that the stock is now aligned to the right side
face of the part geometry in the Z axis of the lathe.



Defining the Machine Setup 31

© 2018 MecSoft Corporation

Specify the Material

We will now set the material for the stock geometry.  The material definition can be used for
display purposes as well as to compute feeds and speeds values for machining.

1. From the Program tab select Material to display the dialog.



VisualCAM 2018 for SOLIDWORKS-TURN Quick Start32

© 2018 MecSoft Corporation

2. For Material, select Aluminum-6061 from the list of available materials and then pick
OK.

3. If the material texture does not display on the stock, select the Material Texture
Visibility icon located at the base of the Machining Browser.
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The Machining Setup

Now let's discuss the Machining Setup.

The Setup icon (  ) displayed in the Machining Job tree defines the Turn Machine
Coordinate System or (MCS) and is defined automatically.  CNC Turning centers or Lathes
use the Cartesian coordinate system for programmed coordinates. 

They follow the convention that the spindle axis of rotation is designated as the Z axis.  The
axis perpendicular to this axis along which the tool travels to cut into the stock is designated
as the X axis.  

So the part and spindle rotate about the Z-axis and moving the tool along the Z-axis provides
the direction of feed and moving it along the X-axis provides the depth of cut.

By default, in the TURN module, the lathe Z axis is aligned with the World X axis and the lathe
X axis is aligned with the World Y axis.  (The Lathe Y axis points in the same direction of the
World Z axis.)

The Turn Machine Coordinate System (MCS) is displayed as a triad with a Blue Z-axis, a
Red X-axis and a Green Y-axis. The World Coordinate System or (WCS) is displayed the
same way
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MCS WCS

Orientation
Parallel to

Triad Display States

MCS Visibility ON

WCS Visibility OFF

MCS Visibility OFF

WCS Visibility ON

MCS Visibility ON

WCS Visibility ON

Front View

SolidWorks also displays the World Coordinate System at the
lower left corner of the screen.  This triad only shows the

orientation of the WCS and not the location.  The WCS displayed
by VisualCAM for SolidWorks shows both the orientation and the
location.  The WCS triad displayed by SolidWorks has the axes
letters next to the arrows.

By default Setup 1 is created when a new part is loaded.  The
MCS of this setup is oriented as described above.  That is,

the world XY plane is the same as the Lathe ZX plane.  This
cannot be changed.  In the future, when you create a part profile
for turning, create it in the XY plane of the WCS.

Set the Work Zero

The Work Zero is used to define the work-piece origin. The Work Zero translates the Machine
Coordinate System (MCS) origin from the origin defined in the Setup to the desired Work Zero
location. This can be set to any location along the lathe Z axis. Typically this is set to the right
most face of the part or stock geometry on the lathe Z axis.

It is important to understand that the Work Zero defines the
zero point from which all toolpath points are interpreted by the

controller.  This would normally be the same as the tool touch off
point on the actual work-piece on your machine.  So care should
be taken to make sure that this Work Zero point matches the tool
zero point used on the actual work piece located in your machine.



Defining the Machine Setup 35

© 2018 MecSoft Corporation

1. From the Program tab select Work Zero to display the dialog.

2. Select Set to Stock Box and set the Zero Face to Right Most. This locates the
machine origin point to the right most face of the stock geometry along the lathe Z
axis.
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3. Pick Generate and notice that the MCS is translated and that the Work Zero now
appears under Setup 1 in the Machining Browser.
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Create a Cutting Tool

To machine our part we will create a diamond insert with a 20 degree relief angle, a 0.02 inch
tip radius and with 0.5 inch inscribed circle radius.

1. Select the Tools tab under the Machining Objects Browser and click the Create/Edit
Tools icon.

1. This will display the Create/Select Tool dialog.  Select the Diamond Insert tool icon
from the top-left side of the dialog.

2. Now set the following parameters in the dialog:

· Set Name as Diamond Insert-OD.

· Inscribed Circle Radius to 0.5

· Tip Radius to 0.02  

· Tip Angle to 55  

· Relief Angle to 20  

· Thickness to 0.125  

· Orientation to OD Forward  
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4. Next, we'll switch to the Feeds and Speeds tab and use the following values.
For Spindle Parameters we'll set:

· Speed to 300 RPM  

· Max Speed to 350 RPM  

For Feedrates we'll select IPM and set:

· Plunge to 5  

· Approach to 7.5  

· Engage to 7.5  

· Cut to 10  

· Retract to 15  

· Departure to 15  

· Transfer to Use Rapid  
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5. Now, we'll pick Save as New Tool.

In the future you can edit tool parameters and click Save
Edits to Tool to save the changes. You can create additional

tools by assigning a different Name and tool parameters.

6. Now the tool is created and listed under Tools in Session on the left.

7. Pick OK to close the dialog and notice that the new tool is also listed under the Tools
Tab of the Machining Objects Browser.
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In the future, to save Tools to a library, click Save Tool library
under the Tools tab in Machining Objects Browser and

specify a folder location and file name in the Save as dialog box.
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Roughing the Outer Diameter

Now were ready to create our Turn Roughing operation for machining the part.

1. From the Program tab select Turning and then Roughing from the menu of operations.

2. This will display the Turn Roughing operation dialog.
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Select the Cutting Tool

Next we'll select the cutting tool for the Turn Roughing operation.

1. From the Tool tab we'll select the Diamond Insert-OD tool we just created as the
active tool. 
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2. The diamond insert is now selected as the active tool.

The Tool parameters of the currently active tool are always
displayed in the status bar at the bottom of the Machining

Objects browser as shown below.
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Set Feeds and Speeds

Next we'll set the Feeds and Speeds for the Turn Roughing operation.

1. Pick the Feeds & Speeds tab of the dialog.  
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2. Then pick the Load from Tool button. The system will retrieve the feed and speed
parameters that we set when we created the tool and associate them with the current
operation.

Set Clearance Geometry

Next we'll set the Clearance Geometry for the Turn Roughing operation.

1. Select the Clearance Geometry tab of the dialog.
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2. Here, we'll set Clearance Settings to Automatic and Cut Transfer to Clearance Plane.

In the Automatic mode, the system will determine a safe height for locating the
clearance plane.  Setting Cut Transfer to Clearance Plane will force all transfer moves
to be performed in this computed clearance plane.

3. When this dialog is active, the clearance plane is shown on the graphics screen.
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Set Global Parameters

Next we'll set the Global Parameters for the Turn Roughing operation to specify parameters to
control the cutting.

1. Switch to the Global Parameters tab of the dialog. 

2. Here, we'll set the Approach Type to Outer Diameter.

3. We'll set Stock to 0.01.  This means that we'll be leaving a 0.01" thickness on the part
after machining.
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Set Roughing Parameters

Next we'll set Roughing Parameters for the Turn Roughing operation.

1. Select the Turn Roughing tab of the dialog.

2. Set Cut Pattern Type to Linear Cuts.
This will create a cut pattern with straight line cuts.  Offset cuts on the other hand will
create cuts that are successive offsets of the TURN profile.

3. Set Cut Direction to Positive.
This will ensure that the cut traverses along the positive Z axis of the Lathe coordinate
system.

4. Then uncheck Final Cleanup Pass.

5. Then also set Depth per Cut to 0.0625.  

Note that Depth per Cut is always set to an absolute value.
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Set Entry/Exit Parameters

Next we'll set Entry and Exit Parameters for the Turn Roughing operation.  Entry/Exit
parameters control how the cutter will engage material as it begins cutting and how it will
leave the material as it completes cutting. 

1. Select the Entry/Exit tab of the dialog.

2. Select the Entry tab and set the Approach Motion Length (AL) to 0.025.

3. We'll then set the Engage Motion Length (EL) to 0.025 also.
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4. Next, we'll switch to Exit tab set the Retract Motion Length (RL) to 0.025 and do the
same for the Depart Motion Length (DL). 
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5. Now pick Generate. 

The Turn Roughing toolpath is generated and the operation is listed under Setup 1 in
the Machining Browser. 

6. Now from the View toolbar in SolidWorks, select the Front View and you can see the
toolpath displayed clearly in the graphics screen.
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The display of the toolpath in the graphics screen can be
turned on/off by selecting the Toolpath Visibility icon in the

toolbar at the bottom of the Machining Browser.
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Simulate the Toolpath

The generated toolpath can now be simulated to display the in-process stock model by using
the functions under the Simulate tab in the Machining browser.

1. Switch to the Simulate tab at the top of the Machining Browser.

2. From the SolidWorks View toolbar, change to the Isometric View.

3. In the TURN module the rendering mode of the simulation model can be controlled for
better visibility by using cut away section views.  Three modes, in addition to the
normal rendering mode, are available.  These are 3 Quarter, Half and Quarter views. 
These display modes can be set in the Simulation Preferences dialog.  They can be
useful when you are machining parts with inner diameter features.

3 Quarter View Half View Quarter View
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4. From the Simulate tab, select Preferences and set the Simulation display mode to 3
Quarter and the Simulation Accuracy to Fine and then pick OK.



VisualCAM 2018 for SOLIDWORKS-TURN Quick Start56

© 2018 MecSoft Corporation

5. From the Simulate tab, uncheck Simulate by Moves and then move the slider to the
left to slow down the simulation speed. 
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6. Now select the Turn Roughing operation under Setup 1 and then pick Play.

You can stop the simulation at anytime by selecting the
Pause button from the Simulate tab.  After Pausing, you can

choose either Play to continue or Stop to exit the simulation.

7. Once the simulation is complete, the state of the stock model is displayed in the
graphics screen.
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8. To view the cut model with textures applied, select the Material Texture Visibility icon
located at the base of the Machining Browser.
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Finishing Outer Diameter

Now we will turn our attention to finishing the outer diameter of the part using the same tool as
we used for roughing.

1. Switch back to Program tab in the Machining Browser.

2. Select Turning and then Finishing from the menu. 

3. This will display the Turn Finishing operation dialog shown below.

Set Finishing Parameters

Here we will use the Turn Finishing dialog to set our finishing parameters:

1.  From the Tool tab in the Turn Finishing dialog select the Diamond Insert-OD tool. 
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2. Now, pick the Feeds & Speeds tab and select the Load from Tool button. The system
will retrieve the feeds and speeds parameters that was set when the tool was defined
and associate them with the current operation.
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3. Pick the Clearance Geometry tab and set the Clearance Settings to Automatic and
Cut Transfer to Clearance Plane.
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4. Now we'll switch to the Global Parameters tab to specify parameters to control the
cutting.

5. Set the Approach Type to Outer Diameter and Stock = 0.  
We will not be leaving any thickness on the part after machining, effectively removing
all stock left over from the previous roughing operation.

6. Now under Cut Containment, check the box for Select Start & End Points.
This allows you to specify an area to contain the toolpath by selecting cut start and
end points. This is useful in cases where only a section of the part needs to be
machined.

7. In this guide, we will graphically select the start and end points from the part to specify
cut containment.  Click on the Pick button.  This minimizes the dialog and prompts
you to select start and end points.
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8. From the View toolbar, we'll switch to Front View.

9.
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Select the edge near the face of the part on OD as shown in the picture below.

Now select the edge at the other end of the part as shown below.

10. The Turn Finishing dialog reappears and displays Start and End point coordinate
values for the cut containment.

11. Leaving all other parameters with default settings, we pick Generate.  The operation is
generated and added to the Machining Job in the Machining Browser below the Turn
Roughing operation we previously created.
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Simulate the Toolpath

We're now ready to Simulate the operation.

1. First make sure the Turn Finishing toolpath is selected from the Machining Job tree.

2. Select the Simulate tab.

3. From the View toolbar change back to the Isometric View.
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4. Now pick Play to view the simulation.
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Post-Process the Toolpath

With the toolpaths complete we're ready to post-process to an output text file containing G-
codes that can then be sent to the machine tool to actually machine the part.

1. Select Setup 1 from the Machining Browser, right-click and select Post.

2. This will post-process all operations created under Setup 1.

3. By default, the Part file name and the Setup name are appended for the G-code file
name.  Also by default, the posted G-code file is saved to the folder where the part file
is located.  
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The post by default is set to Fanuc as we specified under the
Select the Post Processor section of this guide. You can

change the post processor here by selecting a different one from
the Current Post list.  The posted g code by default will be saved
to the folder where the part file is located.

4. Now pick Post and the G-code file is displayed in Notepad where it can be viewed or
edited manually. 
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5. Now close Notepad.



VisualCAM 2018 for SOLIDWORKS-TURN Quick Start70

© 2018 MecSoft Corporation

Generate Reports

Machining Information

At any time, you can create an Information Report of your Machining Operations. 

1. From the Program tab, select Setup 1 under the Machining Job.

2. Right-click and select Information to display and Print the report.

This dialog provides an estimate of the machining time required for the operations in
the Setup.

You can perform the same right-click sequence on the Machining Job to determine the
estimated machining time for all Setups. 
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3. Now pick OK to close the Information dialog.

Shop Documentation

You can also create a Setup Sheet by generating a Shop Document. This is typically used to
instruct machine operators on how to setup and machine the part on the CNC machine.

1. Select Setup1 under the Machining Job tree in the Machining Browser.

2. Right-click and select Shop Documentation.

3. Select Template1.  You can also select from one of the additional HTML templates
that are shipped with the product and generate shop documentation.
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4. This creates an HTML based Shop Document.  This file can then be printed and/or
viewed in a web browser such as Internet Explorer. 
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5. You can perform the same right-click sequence on the Machining Job to generate
Shop Documentation for all Setups.
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Where to go for more help

If you need additional help please take advantage of the following MecSoft resources:

1. Quick Start Guides  
VisualCAM for SOLIDWORKS includes step-by-step Quick Start Guides to help you
get started using the program.  You can find these and other resources on the
Learning Resources dialog.

2. On-Line Help  
The on-line help distributed with the product is a great resource to find reference
information on the various functions available.  You will links to the online help for each
module and other resources on the Learning Resources dialog.

3. MecSoft.com Resources Page  
You can find learning materials and industry resources on the MecSoft.com
Resources Page.

4. Free Videos  
You can visit the MecSoft Corporation YouTube Channel to watch videos.  Note that
the functionality of MecSoft's CAM products is very similar across each of the different
platforms that we support!

5. MecSoft Blog  
You can visit the MecSoft Blog for short articles about using our products.

6. Case Studies  
You can also visit our real-world Case Studies page to learn how others are using
MecSoft products in their workshops.

7. Support Forums  
If you are an active AMS (Annual Maintenance Subscription) user, you have free
access to our Premium Support Forums where you can discuss projects with other
experienced users that eager to assist.  If you are new or have recently signed up for
AMS, this document will show you how to access the Premium Support Forums. 
Want  to sign up for AMS?  Just give a call at 949-654-8163 (select Option 1 for
Sales).

8. MecSoft Support  
If you need additional help, or if you have any questions regarding VisualCAM for
SOLIDWORKS, you may contact us via e-mail at support@mecsoft.com or our online
support page.

9. On-Demand Training  
MecSoft Corporation offers On-Demand Training as well as personalized full day
training sessions. Please look up our website or email us at sales@mecsoft.com for
further details

10. Product Page  
Please do continue to visit the VisualCAM for SOLIDWORKS product page to learn
about the latest updates and additional help material.

https://mecsoft.com/resources/
https://mecsoft.com/resources/
https://www.youtube.com/MecSoftCorporation
https://mecsoft.com/blog/category/blog-posts/learn-cadcam/
https://mecsoft.com/casestudies/
http://www.mecsoft.com/guest/Support Documents/2017/How to Access CAMJam from VisualSERVE.pdf
mailto:support@mecsoft.com
https://mecsoft.com/request-support/
https://mecsoft.com/request-support/
https://mecsoft.com/ondemandtraining/
mailto:sales@mecsoft.com
https://mecsoft.com/visualcamforsolidworks/
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